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Discover the Mann-Whitney U Test in SPSS! Learn how to perform, understand SPSS output, and report results in APA style. Check out this simple, easy-to-follow guide below for a quick read!Struggling with the Mann-Whitney U Test in SPSS? Were here to help. We offer comprehensive assistance to students, covering assignments, dissertations,
research, and more. Request Quote Now!Understanding the intricacies of statistical analysis plays a pivotal role in modern research. Among the various statistical tests, the Mann-Whitney U Test stands out as a nonparametric test often utilised to compare differences between two independent groups. This test is particularly useful when the
assumptions required for parametric tests, such as the independent samples t-test, are not met. In this blog post, we will delve into the Mann-Whitney U Test within the context of SPSS, providing a comprehensive guide on its usage, interpretation, and reporting.By the end of this article, readers will gain a solid understanding of how to perform the
Mann-Whitney U Test in SPSS, interpret the results accurately, and report findings according to APA guidelines. Whether you are a novice or an experienced researcher, this guide aims to equip you with the necessary knowledge to effectively apply the Mann-Whitney U Test in your own data analysis projects.2. What is the Mann-Whitney U Test in
Statistics?The Mann-Whitney U Test serves as a nonparametric alternative to the independent samples t-test. Unlike parametric tests, it does not assume that the data follow a normal distribution. Instead, it compares the ranks of values from two independent groups, making it particularly useful when dealing with ordinal data or when the sample
size is small. The test evaluates whether there is a significant difference in the distributions of the two groups.Firstly, the Mann-Whitney U Test calculates the ranks of all the values from both groups combined. Secondly, it sums the ranks for each group separately and uses these sums to determine the U statistic. This test assesses whether the ranks
in one group tend to be higher or lower than the ranks in the other group. As a result, researchers can draw conclusions about the central tendencies and distributions of the two groups being compared.3. What is the Mann-Whitney U Test used for?The Mann-Whitney U Test in SPSS serves as a powerful tool for comparing two independent groups,
especially when the data do not adhere to the assumptions required for parametric tests. Researchers employ this test across various fields, such as psychology, medicine, and social sciences, to examine differences between groups. For instance, it can be utilised to compare patient outcomes between a treatment group and a control group, or to
assess whether two different teaching methods yield significantly different student performances.Furthermore, the Mann-Whitney U Test is invaluable when dealing with ordinal data or continuous data that are not normally distributed. By leveraging SPSSs capabilities, users can efficiently handle large datasets and complex analyses, ensuring
accurate results. This test helps researchers draw meaningful conclusions about their data, even when traditional parametric methods are unsuitable, thereby enhancing the robustness and reliability of their findings.4. What is the Mann-Whitney U Test in SPSS?The Mann-Whitney U Test in SPSS involves a straightforward procedure to compare the
ranks of two independent samples. Firstly, users input their data into SPSS and select the Mann-Whitney U Test from the nonparametric tests menu. SPSS then ranks all the values from both groups combined and calculates the sum of the ranks for each group. These rank sums form the basis for computing the U statistic.Secondly, SPSS provides the
U statistic along with a p-value, which indicates whether the observed difference in ranks between the two groups is statistically significant. A low p-value (typically less than 0.05) suggests a significant difference in the distributions of the two groups. This process allows researchers to make informed decisions based on their data, even when
traditional parametric assumptions do not hold.5. What is the difference between the Independent Sample t-test and the Mann-Whitney U Test?The independent samples t-test and the Mann-Whitney U Test both compare differences between two independent groups, but they differ significantly in their assumptions and applications. Firstly, the
independent samples t-test assumes that the data are normally distributed and have equal variances across groups. This parametric test compares the means of the two groups to determine if there is a significant difference.Layout of Parametric vs Nonparametric StatisticsIn contrast, the Mann-Whitney U Test does not require normality or
homogeneity of variance, making it a nonparametric alternative. Instead of comparing means, it evaluates the ranks of the data, making it suitable for ordinal data or continuous data that are not normally distributed. Therefore, researchers opt for the Mann-Whitney U Test when their data do not meet the stringent assumptions required for the t-test,
ensuring a more flexible and robust analysis.6. What Are Other Nonparametric Tests?7. What are the Assumptions of the Mann-Whitney U Test in SPSS?Independence: The two samples must be independent of each other.Measurement Scale: The dependent variable should be ordinal or continuous.Group Categorisation: The independent variable
should consist of two categorical, independent groups.Independent Observations: Observations within each group must be independent.Distribution Shape: The distributions of the two groups should have the same shape.8. What is the Hypothesis of the Mann-Whitney U Test in SPSS?The Mann-Whitney U Test operates under two hypotheses.The null
hypothesis (HO): there is no difference in the distribution of the two groups.The alternative hypothesis (H1): There is a significant difference in the distributions of the two groupsRejecting the null hypothesis in favour of the alternative suggests that the two groups differ in a meaningful way.9. An Example of the Mann-Whitney U Test in SPSSConsider
a study aiming to compare the test scores of two independent groups of students: those who received traditional classroom instruction and those who participated in online learning. To perform the Mann-Whitney U Test in SPSS, input the test scores for both groups into the software. Select the Mann-Whitney U Test from the nonparametric tests
menu and run the analysis.The SPSS output will include the U statistic and a p-value. If the p-value is less than 0.05, we reject the null hypothesis, indicating a significant difference in test scores between the two groups. This result would suggest that the mode of instruction impacts student performance, providing valuable insights for educators and
policymakers.Lets embark on a step-by-step guide on performing the Mann-Whitney U Test using SPSSInput Data: Enter the data into SPSS, ensuring that the dependent variable (e.g., test scores) and the independent variable (e.g., group type) are correctly labelled.Select the Test: Navigate to Analyze > Nonparametric Tests > Legacy Dialogs > 2
Independent Samples.Choose Variables: Select the dependent variable for Test Variable List and the independent variable for Grouping Variable. Define the groups appropriately.Run the Test: Click OK to run the Mann-Whitney U Test.Interpret Output: SPSS will provide the U statistic, Z score, and p-value. A p-value less than 0.05 indicates a
significant difference between the groups.Note: Conducting the Mann-Whitney U Test in SPSS provides a robust foundation for understanding the key features of your data. Always ensure that you consult the documentation corresponding to your SPSS version, as steps might slightly differ based on the software version in use. This guide is tailored
for SPSS version 25, and for any variations, its recommended to refer to the softwares documentation for accurate and updated instructions.The SPSS output for the Mann-Whitney U Test typically includes several key tables, including Descriptive Statistics, Ranks, Test Statistics TablesThe ranks table displays the mean ranks for each group, helping
to understand the direction of any differences.The Test Statisticstable provides the U statistic, Z score, and p-value. The p-value determines the significance of the results.If the p-value is less than 0.05, it suggests a significant difference in the distributions of the two groups. Researchers should then examine the mean ranks to understand which
group tends to have higher or lower values. Additionally, the Z score offers insight into the magnitude of the difference between groups. Together, these elements enable a comprehensive interpretation of the test results.13. How to Report Results of Mann-Whitney U Test in APAReporting the results of Mann Whitney u Test in APA (American
Psychological Association) format requires a structured presentation. Heres a step-by-step guide in list format:Introduction: Begin by describing the purpose of the analysis. The Mann-Whitney U Test aims to determine whether there is a significant difference between two independent groups when the data do not meet the assumptions required for
parametric tests.Method: Detail the data collection process and the variables involved. Specify that the test ranks all values from both groups combined, then calculates the sum of the ranks for each group to determine the U statistic. Mention the grouping variable and the dependent variable used in the test.Results: Present the key statistics from the
SPSS output. Report the U statistic, Z score, and the asymptotic significance (p-value).Discussion: Interpret the results, highlighting the significance of the findings. Explain what the lack of a significant difference means in the context of the research question.Conclusion: Summarise the main points of the analysis. Reinforce the finding that there was
no significant difference between the groups. Suggest potential areas for further research, such as examining other factors that might influence student performance or using larger sample sizes for increased power.Example of Mann-Whitney U Test Results in APA StyleGet Help For Your SPSS AnalysisEmbark on a seamless research journey with
SPSSAnalysis.com, where our dedicated team provides expert data analysis assistance for students, academicians, and individuals. We ensure your research is elevated with precision. Explore our pages;Connect with us at SPSSAnalysis.com to empower your research endeavors and achieve impactful data analysis results. Get a FREE Quote Today!
The Mann-Whitney U test is used to compare differences between two independent groups when the outcome (dependent) variable is either ordinal or continuous. It is commonly applied when the data is not normally distributed, thus violating the normality assumption required for a t-test. In such cases, the Mann-Whitney U test serves as a non-
parametric alternative to the Independent Samples t-test, as it does not assume a specific data distribution. This test is particularly useful for small sample sizes where the t-test may be unreliable. The dependent variable must be either ordinal or continuous. Below, we discuss these types of variables with examples. An ordinal variable represents
data with a meaningful order or ranking, but the intervals between categories are not equal and cannot be quantified. Likert scale responses (e.g., strongly agree, agree, neutral, disagree, strongly disagree) Education levels (e.g., High school, Bachelors, Masters, PhD) These examples show a clear ranking, but the differences between the levels are
not quantifiable. A continuous variable, on the other hand, can take any value within a given range, and the difference between values can be measured or quantified. Continuous variables are measured on a scale and may include decimal values. Height (e.g., 4.3 feet, 6.1 feet) Weight (e.g., 60.5 kg, 90.3 kg) Temperature (e.g., 97.7F, 100.4F) In
summary, continuous variables are measured on a continuous scale, whereas ordinal variables represent ranked categories without equal intervals between them. The Mann-Whitney U test can be used in the following examples to compare two independent groups. In the first three examples, the dependent variable is ordinal, while in the fourth, the
dependent variable is continuous. Scenario: A researcher wants to compare post-operative pain levels between patients who underwent two different types of surgery: minimally invasive surgery vs. traditional open surgery. Dependent Variable: Pain levels measured on an ordinal scale (e.g., 1 = No pain, 2 = Mild pain, 3 = Moderate pain, 4 = Severe
pain). Independent Variable: Type of surgery, with two independent groups: minimally invasive surgery and traditional open surgery. Scenario: A business wants to know whether customer satisfaction varies depending on the payment method. Dependent Variable: Customer satisfaction, measured on an ordinal scale (e.g., 1 = Very dissatisfied, 2 =
Dissatisfied, 3 = Neutral, 4 = Satisfied, 5 = Very satisfied). Independent Variable: Payment method, with two independent groups: online payment and cash payment. Scenario: A company investigates whether employee stress levels differ between remote workers and office workers. Dependent Variable: Stress levels, measured on an ordinal scale
(e.g., 1 = Low stress, 2 = Moderate stress, 3 = High stress). Independent Variable: Work setting, with two independent groups: remote work and office work. Scenario: A researcher wants to determine whether systolic blood pressure differs between smokers and non-smokers. Dependent Variable: Systolic blood pressure, a continuous variable
measured in mmHg (e.g., 120 mmHg, 135 mmHg). Independent Variable: Smoking status, with two independent groups: smokers and non-smokers. The two groups being compared must be independent of each other. The dependent (outcome) variable must be ordinal or continuous. Each groups data must be independent (i.e., no participant can
appear in both groups). The shape of the distribution for the dependent variable should be similar for each group. In this example, a researcher examines whether male and female movie ratings differ. Data was collected from 20 males and 20 females, along with their respective ratings. The dependent variable is the movie rating, while the
independent variable is gender, with two independent groups (male and female). Null Hypothesis: There is no difference in movie ratings between males and females. Alternative Hypothesis: There is a difference in movie ratings between males and females. Check out how to perform the Mann-Whitney U test using R for the example. Interestingly, we
got the same results using two different software. STEP 1: For us to perform the test in SPSS, we need to import and organize the data in SPSS. Therefore, we will group male and female data into a gender variable and allocate value 1 for males and value 2 for females. The figures below show both the data view and variable view of our imported and
organized data. STEP 2: Select Analyze Nonparametric Tests Legacy Dialogs 2 Independent Samples as shown below STEP 3: In the new window, move the dependent variable (movie rating) to the Test Variable List and the independent variable (gender) to the Grouping Variable box. Then click on Define Groups to specify group codes (1 for males, 2
for females). STEP 4: Define the groups in the new window by entering the corresponding codes (1 for males, 2 for females), then click Continue. STEP 5: Click the Options tab, check Descriptives and Quartiles, then click Continue. After this, click OK to run the test and generate the output. STEP 6: The output will appear in the SPSS output window
as shown below. The table below presents the descriptive statistics for gender and movie ratings, showing values for the number of observations (N), mean, standard deviation, minimum, maximum, and percentiles. Descriptive StatisticsNMeanStd. DeviationMinimumMaximumPercentiles25th50th (Median)75thMovie
Ratings405.8937.802384.688.215.42005.71505.9650Gender401.5000.506371.002.001.00001.50002.0000 The table below shows the ranks, including the number of observations (N), mean rank, and sum of ranks for the two independent groups (male and female). RanksGenderNMean RankSum of RanksMovie
RatingsMale2020.75415.00Female2020.25405.00Total40 The Mann-Whitney U test produced a U value of 195.000 and a p-value of 0.892. Since p > 0.05, we fail to reject the null hypothesis and conclude that there is no significant difference in movie ratings between males and females. es. Test StatisticsMovie RatingsMann-Whitney
U195.000Wilcoxon W405.000Z-.135Asymp. Sig. (2-tailed).892Exact Sig. [2*(1-tailed Sig.)].904b H2: Interpreting Mann Whitney U Test SPSS Results in APA Format A Mann-Whitney U test was conducted to assess the difference in movie ratings between males and females. The test indicated no significant difference between the two groups (U = 195,
p = 0.892). Thus, we fail to reject the null hypothesis, concluding that there is no significant difference in movie ratings between males and females. Take the Tour Plans & Pricing SIGN UP The Mann-Whitney U test is used to compare differences between two independent groups when the dependent variable is either ordinal or continuous, but not
normally distributed. For example, you could use the Mann-Whitney U test to understand whether attitudes towards pay discrimination, where attitudes are measured on an ordinal scale, differ based on gender (i.e., your dependent variable would be "attitudes towards pay discrimination" and your independent variable would be "gender", which has
two groups: "male" and "female"). Alternately, you could use the Mann-Whitney U test to understand whether salaries, measured on a continuous scale, differed based on educational level (i.e., your dependent variable would be "salary" and your independent variable would be "educational level", which has two groups: "high school" and "university").
The Mann-Whitney U test is often considered the nonparametric alternative to the independent t-test although this is not always the case. Unlike the independent-samples t-test, the Mann-Whitney U test allows you to draw different conclusions about your data depending on the assumptions you make about your data's distribution. These conclusions
can range from simply stating whether the two populations differ through to determining if there are differences in medians between groups. These different conclusions hinge on the shape of the distributions of your data, which we explain more about later. In our enhanced Mann-Whitney U test guide, we take you through all the steps required to
understand when and how to use the Mann-Whitney U test, showing you the required procedures in SPSS Statistics, and how to interpret and report your output. You can access this enhanced Mann-Whitney U test guide by subscribing to Laerd Statistics. In this "quick start" guide, we show you the basics of the Mann-Whitney U test using one of
SPSS Statistics' procedures when the critical assumption of this test is violated. Before we show you how to do this, we explain the different assumptions that your data must meet in order for a Mann-Whitney U test to give you a valid result. We discuss these assumptions next. SPSS Statistics Assumptions of the Mann-Whitney U test When you choose
to analyse your data using a Mann-Whitney U test, part of the process involves checking to make sure that the data you want to analyse can actually be analysed using a Mann-Whitney U test. You need to do this because it is only appropriate to use a Mann-Whitney U test if your data "passes" four assumptions that are required for a Mann-Whitney U
test to give you a valid result. In practice, checking for these four assumptions just adds a little bit more time to your analysis, requiring you to click a few more buttons in SPSS Statistics when performing your analysis, as well as think a little bit more about your data, but it is not a difficult task. Before we introduce you to these four assumptions, do
not be surprised if, when analysing your own data using SPSS Statistics, one or more of these assumptions is violated (i.e., is not met). This is not uncommon when working with real-world data rather than textbook examples, which often only show you how to carry out a Mann-Whitney U test when everything goes well! However, dont worry. Even
when your data fails certain assumptions, there is often a solution to overcome this. First, lets take a look at these four assumptions: Assumption #1: Your dependent variable should be measured at the ordinal or continuous level. Examples of ordinal variables include Likert items (e.g., a 7-point scale from "strongly agree" through to "strongly
disagree"), amongst other ways of ranking categories (e.g., a 5-point scale explaining how much a customer liked a product, ranging from "Not very much" to "Yes, a lot"). Examples of continuous variables include revision time (measured in hours), intelligence (measured using IQ score), exam performance (measured from 0 to 100), weight (measured
in kg), and so forth. You can learn more about ordinal and continuous variables in our article: Types of Variable. Assumption #2: Your independent variable should consist of two categorical, independent groups. Example independent variables that meet this criterion include gender (2 groups: male or female), employment status (2 groups: employed
or unemployed), smoker (2 groups: yes or no), and so forth. Assumption #3: You should have independence of observations, which means that there is no relationship between the observations in each group or between the groups themselves. For example, there must be different participants in each group with no participant being in more than one
group. This is more of a study design issue than something you can test for, but it is an important assumption of the Mann-Whitney U test. If your study fails this assumption, you will need to use another statistical test instead of the Mann-Whitney U test (e.g., a Wilcoxon signed-rank test). If you are unsure whether your study meets this assumption,
you can use our Statistical Test Selector, which is part of our enhanced content. Assumption #4: A Mann-Whitney U test can be used when your two variables are not normally distributed. However, in order to know how to interpret the results from a Mann-Whitney U test, you have to determine whether your two distributions (i.e., the distribution of
scores for both groups of the independent variable; for example, 'males' and 'females' for the independent variable, 'gender') have the same shape. To understand what this means, take a look at the diagram below: Copyright 2013. Laerd Statistics In the two diagrams above, the distribution of scores for 'males' and 'females' have the same shape. In
the diagram on the left, you cannot see the distribution of scores for 'males' (illustrated in blue on the diagram on the right) because the two distributions are identical (i.e., both distributions are identical, so they are 'on top of each other' in the diagram, with the blue-coloured male distribution underneath the red-coloured female distribution).
However, in the diagram on the right, even though both distributions have the same shape, they have a different location (i.e., the distribution of one of the groups of the independent variable has higher or lower values compared to the second distribution in our example, females have 'higher' values than males, overall). When you analyse your own
data, it is extremely unlikely that your two distributions will be identical, but they may have the same (or a 'similar') shape. If they do have the same shape, you can use SPSS Statistics to carry out a Mann-Whitney U test to compare the medians of your dependent variable (e.g., engagement score) for the two groups (e.g., males and females) of the
independent variable (e.g., gender) you are interested in. However, if your two distribution have a different shape, you can only use the Mann-Whitney U test to compare mean ranks. Therefore, when carrying out a Mann-Whitney U test, you must also use SPSS Statistics to determine whether your two distributions have the same shape or a different
shape. This requires a few more procedures in SPSS Statistics, but it is an easy step-by-step process that we show you how to do in our enhanced Mann-Whitney U test guide. In this "quick start" guide, we show you how to carry out a Mann-Whitney U test assuming that your two distributions do not have a similar shape, such that you can only
compare mean ranks and not medians. You can check assumption #4 using SPSS Statistics. Before doing this, you should make sure that your data meets assumptions #1, #2 and #3, although you don't need SPSS Statistics to do this. Just remember that if you do not check assumption #4, you will not know whether you are correctly comparing mean
ranks or medians, and the results you get when running a Mann-Whitney U test may not be valid. This is why we dedicate a number of sections of our enhanced Mann-Whitney U test guide to help you get this right. You can learn more about assumption #4 and what you will need to interpret in the Assumptions section of our enhanced Mann-Whitney
U test guide, which you can access by subscribing to Laerd Statistics. In the Test Procedure in SPSS Statistics section of this "quick start" guide, we illustrate the SPSS Statistics procedure to perform a Mann-Whitney U test assuming that your two distributions are not the same shape and you have to interpret mean ranks rather than medians. First,
we set out the example we use to explain the Mann-Whitney U test procedure in SPSS Statistics. TAKE THE TOUR PLANS & PRICING The concentration of cholesterol (a type of fat) in the blood is associated with the risk of developing heart disease, such that higher concentrations of cholesterol indicate a higher level of risk, and lower concentrations
indicate a lower level of risk. If you lower the concentration of cholesterol in the blood, your risk for developing heart disease can be reduced. Being overweight and/or physically inactive increases the concentration of cholesterol in your blood. Both exercise and weight loss can reduce cholesterol concentration. However, it is not known whether
exercise or weight loss is best for lowering cholesterol concentration. Therefore, a researcher decided to investigate whether an exercise or weight loss intervention was more effective in lowering cholesterol levels. To this end, the researcher recruited a random sample of inactive males that were classified as overweight. This sample was then
randomly split into two groups: Group 1 underwent a calorie-controlled diet (i.e., the 'diet' group) and Group 2 undertook an exercise-training programme (i.e., the 'exercise' group). In order to determine which treatment programme was more effective, cholesterol concentrations were compared between the two groups at the end of the treatment
programmes. SPSS Statistics Data setup in SPSS Statistics to carry out the Mann-Whitney U test In SPSS Statistics, we entered the scores for cholesterol concentration, our dependent variable, under the variable name Cholesterol. Next, we created a grouping variable, called Group, which represented our independent variable. Since our
independent variable had two groups - 'diet' and 'exercise' - we gave the diet group a value of "1" and the exercise group a value of "2". If you do not label your two groups, SPSS Statistics will not be able to distinguish between them and the Mann-Whitney U test will not run. Note: There are two different procedures in SPSS Statistics to run a Mann-
Whitney U test: the Nonparametric Tests > Independent Samples procedure and Legacy Dialogs > 2 Independent Samples procedure. How we have explained the data setup above relates to both procedures when your dependent variable is continuous, which is what we take you through in the Test Procedure in SPSS Statistics section next. However,
if you are using the Nonparametric Tests > Independent Samples procedure, you have to make changes to your data setup if your dependent variable is ordinal (i.e., as opposed to being continuous). We explain how to do this in our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In our enhanced Mann-
Whitney U test guide, we show you all the steps required to correctly enter data into SPSS Statistics to run a Mann-Whitney U test for both the Nonparametric Tests > Independent Samples and Legacy Dialogs > 2 Independent Samples procedures discussed in the note above. SPSS Statistics SPSS Statistics procedure to carry out a Mann-Whitney U
test If you read assumption #4 earlier, you'll know that the SPSS Statistics procedure when analysing your data using a Mann-Whitney U test is different depending on the shape of the two distributions of your independent variable. In our example, where our dependent variable is cholesterol concentration, Cholesterol, we are referring to the two
distributions of the independent variable, Group (i.e., the distribution of scores for Group 1 the 'diet' group and Group 2 the 'exercise' group). In the 10 steps below, we show you how to analyse your data using a Mann-Whitney U test in SPSS Statistics when these two distributions have a different shape, and therefore, you have to compare the mean
ranks of your dependent variable rather than medians. To use SPSS Statistics to determine whether your two distributions have the same or different shapes, or if you want to know how to use SPSS Statistics to carry out a Mann-Whitney U test when your two distributions have the same shape, such that you need to compare medians rather than
mean ranks, you will need to access the Procedures section of our enhanced Mann-Whitney U test guide (N.B., you can do this by subscribing to Laerd Statistics). Furthermore, the 10 steps below also show you how to carry out a Mann-Whitney U test using the Legacy Dialogs > 2 Independent Samples procedure in SPSS Statistics. As we explained
earlier, there are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and the Legacy Dialogs > 2 Independent Samples procedure. We recommend the Nonparametric Tests > Independent Samples procedure if your two distributions have the same shape because it is
a little easier to carry out, but the Legacy Dialogs > 2 Independent Samples procedure is fine if your two distributions have different shapes. We show you both procedures in our enhanced Mann-Whitney U test guide. At the end of the 9 steps below, we show you how to interpret the results from this test using mean ranks. Note: The procedure that
follows is identical for SPSS Statistics versions 17 to 30, as well as the subscription version of SPSS Statistics, with version 30 and the subscription version being the latest versions of SPSS Statistics. However, in version 27 and the subscription version, SPSS Statistics introduced a new look to their interface called "SPSS Light", replacing the
previous look for versions 26 and earlier versions, which was called "SPSS Standard". Therefore, if you have SPSS Statistics versions 27 to 30 (or the subscription version of SPSS Statistics), the images that follow will be light grey rather than blue. However, the procedure is identical. Click Analyze > Nonparametric Tests > Legacy Dialogs > 2
Independent Samples... on the top menu, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. You will be presented with the Two-Independent-Samples Tests dialogue box, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. Transfer the dependent variable, Cholesterol,
into the Test Variable List: box and the independent variable, Group, into the Grouping Variable: box by using the button or by dragging-and-dropping the variables into the boxes. Published with written permission from SPSS Statistics, IBM Corporation. Note: Make sure that the Mann-Whitney U checkbox is ticked in the Test Type area and the
Grouping Variable: box is highlighted in yellow (as seen above). If it is not highlighted in yellow, simply click your cursor in the Grouping Variable: box to highlight it. Click on the button. The button will not be clickable if you have not highlighted the Grouping Variable: box as instructed in Step 4. You will be presented with the following screen:
Published with written permission from SPSS Statistics, IBM Corporation. Click through to the next page for the remaining procedure and how to interpret the output. Home About Us Contact Us Terms & Conditions Privacy & Cookies 2018 Lund Research Ltd Take the Tour Plans & Pricing SIGN UP The Mann-Whitney U test is used to compare
differences between two independent groups when the dependent variable is either ordinal or continuous, but not normally distributed. For example, you could use the Mann-Whitney U test to understand whether attitudes towards pay discrimination, where attitudes are measured on an ordinal scale, differ based on gender (i.e., your dependent
variable would be "attitudes towards pay discrimination" and your independent variable would be "gender", which has two groups: "male" and "female"). Alternately, you could use the Mann-Whitney U test to understand whether salaries, measured on a continuous scale, differed based on educational level (i.e., your dependent variable would be
"salary" and your independent variable would be "educational level", which has two groups: "high school" and "university"). The Mann-Whitney U test is often considered the nonparametric alternative to the independent t-test although this is not always the case. Unlike the independent-samples t-test, the Mann-Whitney U test allows you to draw
different conclusions about your data depending on the assumptions you make about your data's distribution. These conclusions can range from simply stating whether the two populations differ through to determining if there are differences in medians between groups. These different conclusions hinge on the shape of the distributions of your data,
which we explain more about later. In our enhanced Mann-Whitney U test guide, we take you through all the steps required to understand when and how to use the Mann-Whitney U test, showing you the required procedures in SPSS Statistics, and how to interpret and report your output. You can access this enhanced Mann-Whitney U test guide by
subscribing to Laerd Statistics. In this "quick start" guide, we show you the basics of the Mann-Whitney U test using one of SPSS Statistics' procedures when the critical assumption of this test is violated. Before we show you how to do this, we explain the different assumptions that your data must meet in order for a Mann-Whitney U test to give you a
valid result. We discuss these assumptions next. SPSS Statistics Assumptions of the Mann-Whitney U test When you choose to analyse your data using a Mann-Whitney U test, part of the process involves checking to make sure that the data you want to analyse can actually be analysed using a Mann-Whitney U test. You need to do this because it is
only appropriate to use a Mann-Whitney U test if your data "passes" four assumptions that are required for a Mann-Whitney U test to give you a valid result. In practice, checking for these four assumptions just adds a little bit more time to your analysis, requiring you to click a few more buttons in SPSS Statistics when performing your analysis, as
well as think a little bit more about your data, but it is not a difficult task. Before we introduce you to these four assumptions, do not be surprised if, when analysing your own data using SPSS Statistics, one or more of these assumptions is violated (i.e., is not met). This is not uncommon when working with real-world data rather than textbook
examples, which often only show you how to carry out a Mann-Whitney U test when everything goes well! However, dont worry. Even when your data fails certain assumptions, there is often a solution to overcome this. First, lets take a look at these four assumptions: Assumption #1: Your dependent variable should be measured at the ordinal or
continuous level. Examples of ordinal variables include Likert items (e.g., a 7-point scale from "strongly agree" through to "strongly disagree"), amongst other ways of ranking categories (e.g., a 5-point scale explaining how much a customer liked a product, ranging from "Not very much" to "Yes, a lot"). Examples of continuous variables include
revision time (measured in hours), intelligence (measured using IQ score), exam performance (measured from 0 to 100), weight (measured in kg), and so forth. You can learn more about ordinal and continuous variables in our article: Types of Variable. Assumption #2: Your independent variable should consist of two categorical, independent groups.
Example independent variables that meet this criterion include gender (2 groups: male or female), employment status (2 groups: employed or unemployed), smoker (2 groups: yes or no), and so forth. Assumption #3: You should have independence of observations, which means that there is no relationship between the observations in each group or
between the groups themselves. For example, there must be different participants in each group with no participant being in more than one group. This is more of a study design issue than something you can test for, but it is an important assumption of the Mann-Whitney U test. If your study fails this assumption, you will need to use another
statistical test instead of the Mann-Whitney U test (e.g., a Wilcoxon signed-rank test). If you are unsure whether your study meets this assumption, you can use our Statistical Test Selector, which is part of our enhanced content. Assumption #4: A Mann-Whitney U test can be used when your two variables are not normally distributed. However, in
order to know how to interpret the results from a Mann-Whitney U test, you have to determine whether your two distributions (i.e., the distribution of scores for both groups of the independent variable; for example, 'males' and 'females' for the independent variable, 'gender') have the same shape. To understand what this means, take a look at the
diagram below: Copyright 2013. Laerd Statistics In the two diagrams above, the distribution of scores for 'males' and 'females' have the same shape. In the diagram on the left, you cannot see the distribution of scores for 'males’ (illustrated in blue on the diagram on the right) because the two distributions are identical (i.e., both distributions are
identical, so they are 'on top of each other' in the diagram, with the blue-coloured male distribution underneath the red-coloured female distribution). However, in the diagram on the right, even though both distributions have the same shape, they have a different location (i.e., the distribution of one of the groups of the independent variable has
higher or lower values compared to the second distribution in our example, females have 'higher' values than males, overall). When you analyse your own data, it is extremely unlikely that your two distributions will be identical, but they may have the same (or a 'similar') shape. If they do have the same shape, you can use SPSS Statistics to carry out a
Mann-Whitney U test to compare the medians of your dependent variable (e.g., engagement score) for the two groups (e.g., males and females) of the independent variable (e.g., gender) you are interested in. However, if your two distribution have a different shape, you can only use the Mann-Whitney U test to compare mean ranks. Therefore, when
carrying out a Mann-Whitney U test, you must also use SPSS Statistics to determine whether your two distributions have the same shape or a different shape. This requires a few more procedures in SPSS Statistics, but it is an easy step-by-step process that we show you how to do in our enhanced Mann-Whitney U test guide. In this "quick start"
guide, we show you how to carry out a Mann-Whitney U test assuming that your two distributions do not have a similar shape, such that you can only compare mean ranks and not medians. You can check assumption #4 using SPSS Statistics. Before doing this, you should make sure that your data meets assumptions #1, #2 and #3, although you don't
need SPSS Statistics to do this. Just remember that if you do not check assumption #4, you will not know whether you are correctly comparing mean ranks or medians, and the results you get when running a Mann-Whitney U test may not be valid. This is why we dedicate a number of sections of our enhanced Mann-Whitney U test guide to help you
get this right. You can learn more about assumption #4 and what you will need to interpret in the Assumptions section of our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In the Test Procedure in SPSS Statistics section of this "quick start" guide, we illustrate the SPSS Statistics procedure to perform
a Mann-Whitney U test assuming that your two distributions are not the same shape and you have to interpret mean ranks rather than medians. First, we set out the example we use to explain the Mann-Whitney U test procedure in SPSS Statistics. TAKE THE TOUR PLANS & PRICING The concentration of cholesterol (a type of fat) in the blood is
associated with the risk of developing heart disease, such that higher concentrations of cholesterol indicate a higher level of risk, and lower concentrations indicate a lower level of risk. If you lower the concentration of cholesterol in the blood, your risk for developing heart disease can be reduced. Being overweight and/or physically inactive increases
the concentration of cholesterol in your blood. Both exercise and weight loss can reduce cholesterol concentration. However, it is not known whether exercise or weight loss is best for lowering cholesterol concentration. Therefore, a researcher decided to investigate whether an exercise or weight loss intervention was more effective in lowering
cholesterol levels. To this end, the researcher recruited a random sample of inactive males that were classified as overweight. This sample was then randomly split into two groups: Group 1 underwent a calorie-controlled diet (i.e., the 'diet' group) and Group 2 undertook an exercise-training programme (i.e., the 'exercise' group). In order to determine
which treatment programme was more effective, cholesterol concentrations were compared between the two groups at the end of the treatment programmes. SPSS Statistics Data setup in SPSS Statistics to carry out the Mann-Whitney U test In SPSS Statistics, we entered the scores for cholesterol concentration, our dependent variable, under the
variable name Cholesterol. Next, we created a grouping variable, called Group, which represented our independent variable. Since our independent variable had two groups - 'diet’' and 'exercise' - we gave the diet group a value of "1" and the exercise group a value of "2". If you do not label your two groups, SPSS Statistics will not be able to
distinguish between them and the Mann-Whitney U test will not run. Note: There are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and Legacy Dialogs > 2 Independent Samples procedure. How we have explained the data setup above relates to both procedures
when your dependent variable is continuous, which is what we take you through in the Test Procedure in SPSS Statistics section next. However, if you are using the Nonparametric Tests > Independent Samples procedure, you have to make changes to your data setup if your dependent variable is ordinal (i.e., as opposed to being continuous). We
explain how to do this in our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In our enhanced Mann-Whitney U test guide, we show you all the steps required to correctly enter data into SPSS Statistics to run a Mann-Whitney U test for both the Nonparametric Tests > Independent Samples and Legacy
Dialogs > 2 Independent Samples procedures discussed in the note above. SPSS Statistics SPSS Statistics procedure to carry out a Mann-Whitney U test If you read assumption #4 earlier, you'll know that the SPSS Statistics procedure when analysing your data using a Mann-Whitney U test is different depending on the shape of the two distributions
of your independent variable. In our example, where our dependent variable is cholesterol concentration, Cholesterol, we are referring to the two distributions of the independent variable, Group (i.e., the distribution of scores for Group 1 the 'diet' group and Group 2 the 'exercise' group). In the 10 steps below, we show you how to analyse your data
using a Mann-Whitney U test in SPSS Statistics when these two distributions have a different shape, and therefore, you have to compare the mean ranks of your dependent variable rather than medians. To use SPSS Statistics to determine whether your two distributions have the same or different shapes, or if you want to know how to use SPSS
Statistics to carry out a Mann-Whitney U test when your two distributions have the same shape, such that you need to compare medians rather than mean ranks, you will need to access the Procedures section of our enhanced Mann-Whitney U test guide (N.B., you can do this by subscribing to Laerd Statistics). Furthermore, the 10 steps below also
show you how to carry out a Mann-Whitney U test using the Legacy Dialogs > 2 Independent Samples procedure in SPSS Statistics. As we explained earlier, there are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and the Legacy Dialogs > 2 Independent
Samples procedure. We recommend the Nonparametric Tests > Independent Samples procedure if your two distributions have the same shape because it is a little easier to carry out, but the Legacy Dialogs > 2 Independent Samples procedure is fine if your two distributions have different shapes. We show you both procedures in our enhanced Mann-
Whitney U test guide. At the end of the 9 steps below, we show you how to interpret the results from this test using mean ranks. Note: The procedure that follows is identical for SPSS Statistics versions 17 to 30, as well as the subscription version of SPSS Statistics, with version 30 and the subscription version being the latest versions of SPSS
Statistics. However, in version 27 and the subscription version, SPSS Statistics introduced a new look to their interface called "SPSS Light", replacing the previous look for versions 26 and earlier versions, which was called "SPSS Standard". Therefore, if you have SPSS Statistics versions 27 to 30 (or the subscription version of SPSS Statistics), the
images that follow will be light grey rather than blue. However, the procedure is identical. Click Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples... on the top menu, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. You will be presented with the Two-Independent-Samples Tests
dialogue box, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. Transfer the dependent variable, Cholesterol, into the Test Variable List: box and the independent variable, Group, into the Grouping Variable: box by using the button or by dragging-and-dropping the variables into the boxes. Published with
written permission from SPSS Statistics, IBM Corporation. Note: Make sure that the Mann-Whitney U checkbox is ticked in the Test Type area and the Grouping Variable: box is highlighted in yellow (as seen above). If it is not highlighted in yellow, simply click your cursor in the Grouping Variable: box to highlight it. Click on the button. The button
will not be clickable if you have not highlighted the Grouping Variable: box as instructed in Step 4. You will be presented with the following screen: Published with written permission from SPSS Statistics, IBM Corporation. Click through to the next page for the remaining procedure and how to interpret the output. Home About Us Contact Us Terms &
Conditions Privacy & Cookies 2018 Lund Research Ltd AMann-Whitney U test(sometimes called the Wilcoxon rank-sum test) is used to compare the differences between two samples when the sample distributions are not normally distributed and the sample sizes are small (n Nonparametric Tests -> Legacy Dialogs -> 2 Independent Samples. In the
resulting dialog box, move the score variable to the Test Variable List and the group variable to the Grouping Variable box. Click on "Define Groups" and specify the values used to represent the two groups (e.g., 1 and 2).Ensure the "Mann-Whitney U" test is selected. Then, click "OK" to run the analysis.Interpreting the SPSS OutputThe SPSS output
will provide two key tables: Ranks and Test Statistics. The Ranks table shows the mean rank for each group, which gives an initial indication of any differences between the groups. The Test Statistics table presents the Mann-Whitney U statistic, the Wilcoxon W statistic (which is relevant if your hypothesis concerns the sum of the ranks), the Z-score
(a standardized test statistic), and, most importantly, the p-value.If the p-value is less than the chosen significance level (typically 0.05), the null hypothesis is rejected, meaning that there is a statistically significant difference in test scores between the two teaching methods.Calculating and Interpreting Effect SizeWhile the p-value indicates statistical
significance, it doesn't tell us about the magnitude of the difference. This is where effect size comes in. A common effect size measure for the Mann-Whitney U test is Cliff's Delta. Although SPSS does not directly calculate Cliffs Delta, it can be calculated from the U statistic and sample sizes of the two groups (manual calculation). Cliff's delta ranges
from -1 to +1, with values closer to -1 indicating a large negative effect (one group significantly lower than the other) and values closer to +1 indicating a large positive effect.Another simpler approach is to calculate r, by dividing Z statistic by the square root of sample size, for example: r = Z/sqrt(N). This gives a rough measure of effect
size.Interpreting effect size is crucial for understanding the practical significance of the findings. For instance, even if the p-value is statistically significant, a small effect size might suggest that the difference between teaching methods is not practically meaningful.Example 2: Analyzing Customer Satisfaction RatingsConsider a scenario where a
company wants to compare customer satisfaction ratings between two different product versions (e.g., Version 1 vs. Version 2). Customer satisfaction is measured using an ordinal scale, such as a Likert scale ranging from 1 (very dissatisfied) to 5 (very satisfied).Data Entry and PreparationIn SPSS, create two variables: one for the product version
(coded, for example, as 1 and 2) and another for the customer satisfaction rating (with values from 1 to 5). Enter the data accordingly, ensuring that each customer's rating is associated with the correct product version.Performing the Mann-Whitney U TestThe procedure for running the Mann-Whitney U test in SPSS is the same as in the previous
example. Navigate to Analyze -> Nonparametric Tests -> Legacy Dialogs -> 2 Independent Samples. Specify the customer satisfaction rating as the test variable and the product version as the grouping variable. Define the groups (1 and 2) and run the analysis.Interpreting the Results and Determining Practical SignificanceAs before, analyze the
Ranks and Test Statistics tables in the SPSS output. A significant p-value suggests a difference in customer satisfaction between the two product versions. However, given the ordinal nature of the data, it's especially important to consider the mean ranks and calculate an appropriate effect size measure, such as Cliff's Delta.It is important to calculate
Cliffs Delta manually.Interpreting the effect size alongside the p-value will help determine whether the difference in customer satisfaction is practically meaningful. For example, a statistically significant difference with a small effect size may not justify a costly product update. Conversely, a larger effect size might warrant further investigation and
potential improvements to the lower-rated product version.ReferencesProviding a comprehensive and meticulously formatted list of references is not merely an academic formality; it is an act of intellectual honesty and a critical component of scholarly integrity. This section meticulously catalogs all sources consulted and cited throughout this guide,
ensuring proper attribution and facilitating further exploration for interested readers. The accuracy and completeness of this section are paramount in establishing the credibility and reliability of the presented information.Importance of Accurate CitationRigorous citation practices serve several crucial functions. First, they acknowledge the
intellectual debt owed to previous researchers and scholars, preventing plagiarism and upholding ethical standards.Second, they allow readers to independently verify the information presented and delve deeper into specific topics of interest.Finally, a well-curated reference list demonstrates the depth and breadth of the research underpinning the
guide, enhancing its overall authority.Citation Style and ConsistencyTo maintain clarity and consistency, this guide adheres to the American Psychological Association (APA) 7th edition citation style. All sources are formatted according to APA guidelines, ensuring uniformity and ease of navigation.This includes consistent formatting of author names,
publication years, titles, and source information. Strict adherence to a single style minimizes ambiguity and facilitates accurate retrieval of cited materials.Core References for the Mann-Whitney U TestThe following references represent foundational works and key resources utilized in the development of this guide. They provide a comprehensive
understanding of the Mann-Whitney U test, its theoretical underpinnings, and its practical applications.Conover, W. J. (1999). Practical nonparametric statistics (3rd ed.). John Wiley & Sons. This book offers a comprehensive overview of nonparametric statistical methods, including detailed explanations and examples of the Mann-Whitney U
test.Hollander, M., Wolfe, D. A., & Chicken, E. (2014). Nonparametric statistical methods (3rd ed.). John Wiley & Sons. A classic text providing a rigorous treatment of nonparametric statistics, including the theoretical basis and applications of the Mann-Whitney U test.Mann, H. B., & Whitney, D. R. (1947). On a test of whether one of two random
variables is stochastically larger than the other. The Annals of Mathematical Statistics, 18(1), 50-60. The seminal paper introducing the Mann-Whitney U test, outlining its methodology and statistical properties.Siegel, S., & Castellan, N. J., Jr. (1988). Nonparametric statistics for the behavioral sciences (2nd ed.). McGraw-Hill. A widely used textbook
that provides a clear and accessible introduction to nonparametric statistics, with detailed coverage of the Mann-Whitney U test.IBM Corp. Released 2020. IBM SPSS Statistics for Windows, Version 27.0. Armonk, NY: IBM Corp. The specific version of SPSS software utilized for demonstrating the practical application of the Mann-Whitney U
test.Additional ResourcesIn addition to the core references, the following resources provided supplementary information or were consulted during the preparation of this guide:[Include additional journal articles, websites, and other relevant sources here, formatted according to APA 7th edition.]This comprehensive reference list aims to provide
readers with a solid foundation for further exploration and a clear understanding of the sources underpinning this guide. FAQs: Mann-Whitney U Test SPSS GuideWhen should I use the Mann-Whitney U test in SPSS instead of a t-test?You should use the Mann-Whitney U test in SPSS when your data violates the assumptions of a t-test, particularly
normality. The u mann whitney spss test is a non-parametric alternative suitable for ordinal data or when data is not normally distributed.What does the Mann-Whitney U statistic actually represent?The Mann-Whitney U statistic essentially represents the number of times scores from one group are ranked higher than scores from the other group. In
SPSS, the u mann whitney spss test computes this statistic to determine if there's a significant difference in the distributions of the two groups.How do I interpret the p-value from the Mann-Whitney U test SPSS output?The p-value indicates the probability of observing your results (or more extreme results) if there is no real difference between the
two groups. If the p-value is less than your significance level (usually 0.05), you reject the null hypothesis, suggesting a significant difference. When doing a u mann whitney spss test, a small p-value indicates evidence against the null hypothesis.What if my Mann-Whitney U test result in SPSS is not significant?A non-significant result (p > 0.05)



implies that you do not have enough evidence to conclude that there is a statistically significant difference between the two groups. It doesn't necessarily mean the groups are the same, just that you can't prove they're different based on your data and the u mann whitney spss test. So, there you have it! You're now equipped to tackle non-parametric
data comparisons using the Mann-Whitney U test in SPSS. Go forth and analyze, and remember, if you ever get stuck, just revisit this guide mastering the U Mann Whitney SPSS test is definitely within reach with a little practice! Related Posts: Take the Tour Plans & Pricing SIGN UP The Mann-Whitney U test is used to compare differences between
two independent groups when the dependent variable is either ordinal or continuous, but not normally distributed. For example, you could use the Mann-Whitney U test to understand whether attitudes towards pay discrimination, where attitudes are measured on an ordinal scale, differ based on gender (i.e., your dependent variable would be
"attitudes towards pay discrimination" and your independent variable would be "gender", which has two groups: "male" and "female"). Alternately, you could use the Mann-Whitney U test to understand whether salaries, measured on a continuous scale, differed based on educational level (i.e., your dependent variable would be "salary" and your
independent variable would be "educational level", which has two groups: "high school" and "university"). The Mann-Whitney U test is often considered the nonparametric alternative to the independent t-test although this is not always the case. Unlike the independent-samples t-test, the Mann-Whitney U test allows you to draw different conclusions
about your data depending on the assumptions you make about your data's distribution. These conclusions can range from simply stating whether the two populations differ through to determining if there are differences in medians between groups. These different conclusions hinge on the shape of the distributions of your data, which we explain
more about later. In our enhanced Mann-Whitney U test guide, we take you through all the steps required to understand when and how to use the Mann-Whitney U test, showing you the required procedures in SPSS Statistics, and how to interpret and report your output. You can access this enhanced Mann-Whitney U test guide by subscribing to
Laerd Statistics. In this "quick start" guide, we show you the basics of the Mann-Whitney U test using one of SPSS Statistics' procedures when the critical assumption of this test is violated. Before we show you how to do this, we explain the different assumptions that your data must meet in order for a Mann-Whitney U test to give you a valid result.
We discuss these assumptions next. SPSS Statistics Assumptions of the Mann-Whitney U test When you choose to analyse your data using a Mann-Whitney U test, part of the process involves checking to make sure that the data you want to analyse can actually be analysed using a Mann-Whitney U test. You need to do this because it is only
appropriate to use a Mann-Whitney U test if your data "passes" four assumptions that are required for a Mann-Whitney U test to give you a valid result. In practice, checking for these four assumptions just adds a little bit more time to your analysis, requiring you to click a few more buttons in SPSS Statistics when performing your analysis, as well as
think a little bit more about your data, but it is not a difficult task. Before we introduce you to these four assumptions, do not be surprised if, when analysing your own data using SPSS Statistics, one or more of these assumptions is violated (i.e., is not met). This is not uncommon when working with real-world data rather than textbook examples,
which often only show you how to carry out a Mann-Whitney U test when everything goes well! However, dont worry. Even when your data fails certain assumptions, there is often a solution to overcome this. First, lets take a look at these four assumptions: Assumption #1: Your dependent variable should be measured at the ordinal or continuous
level. Examples of ordinal variables include Likert items (e.g., a 7-point scale from "strongly agree" through to "strongly disagree"), amongst other ways of ranking categories (e.g., a 5-point scale explaining how much a customer liked a product, ranging from "Not very much" to "Yes, a lot"). Examples of continuous variables include revision time
(measured in hours), intelligence (measured using IQ score), exam performance (measured from 0 to 100), weight (measured in kg), and so forth. You can learn more about ordinal and continuous variables in our article: Types of Variable. Assumption #2: Your independent variable should consist of two categorical, independent groups. Example
independent variables that meet this criterion include gender (2 groups: male or female), employment status (2 groups: employed or unemployed), smoker (2 groups: yes or no), and so forth. Assumption #3: You should have independence of observations, which means that there is no relationship between the observations in each group or between
the groups themselves. For example, there must be different participants in each group with no participant being in more than one group. This is more of a study design issue than something you can test for, but it is an important assumption of the Mann-Whitney U test. If your study fails this assumption, you will need to use another statistical test
instead of the Mann-Whitney U test (e.g., a Wilcoxon signed-rank test). If you are unsure whether your study meets this assumption, you can use our Statistical Test Selector, which is part of our enhanced content. Assumption #4: A Mann-Whitney U test can be used when your two variables are not normally distributed. However, in order to know how
to interpret the results from a Mann-Whitney U test, you have to determine whether your two distributions (i.e., the distribution of scores for both groups of the independent variable; for example, 'males' and 'females' for the independent variable, 'gender') have the same shape. To understand what this means, take a look at the diagram below:
Copyright 2013. Laerd Statistics In the two diagrams above, the distribution of scores for 'males' and 'females' have the same shape. In the diagram on the left, you cannot see the distribution of scores for 'males' (illustrated in blue on the diagram on the right) because the two distributions are identical (i.e., both distributions are identical, so they are
'on top of each other' in the diagram, with the blue-coloured male distribution underneath the red-coloured female distribution). However, in the diagram on the right, even though both distributions have the same shape, they have a different location (i.e., the distribution of one of the groups of the independent variable has higher or lower values
compared to the second distribution in our example, females have 'higher' values than males, overall). When you analyse your own data, it is extremely unlikely that your two distributions will be identical, but they may have the same (or a 'similar') shape. If they do have the same shape, you can use SPSS Statistics to carry out a Mann-Whitney U test
to compare the medians of your dependent variable (e.g., engagement score) for the two groups (e.g., males and females) of the independent variable (e.g., gender) you are interested in. However, if your two distribution have a different shape, you can only use the Mann-Whitney U test to compare mean ranks. Therefore, when carrying out a Mann-
Whitney U test, you must also use SPSS Statistics to determine whether your two distributions have the same shape or a different shape. This requires a few more procedures in SPSS Statistics, but it is an easy step-by-step process that we show you how to do in our enhanced Mann-Whitney U test guide. In this "quick start" guide, we show you how to
carry out a Mann-Whitney U test assuming that your two distributions do not have a similar shape, such that you can only compare mean ranks and not medians. You can check assumption #4 using SPSS Statistics. Before doing this, you should make sure that your data meets assumptions #1, #2 and #3, although you don't need SPSS Statistics to do
this. Just remember that if you do not check assumption #4, you will not know whether you are correctly comparing mean ranks or medians, and the results you get when running a Mann-Whitney U test may not be valid. This is why we dedicate a number of sections of our enhanced Mann-Whitney U test guide to help you get this right. You can learn
more about assumption #4 and what you will need to interpret in the Assumptions section of our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In the Test Procedure in SPSS Statistics section of this "quick start" guide, we illustrate the SPSS Statistics procedure to perform a Mann-Whitney U test
assuming that your two distributions are not the same shape and you have to interpret mean ranks rather than medians. First, we set out the example we use to explain the Mann-Whitney U test procedure in SPSS Statistics. TAKE THE TOUR PLANS & PRICING The concentration of cholesterol (a type of fat) in the blood is associated with the risk of
developing heart disease, such that higher concentrations of cholesterol indicate a higher level of risk, and lower concentrations indicate a lower level of risk. If you lower the concentration of cholesterol in the blood, your risk for developing heart disease can be reduced. Being overweight and/or physically inactive increases the concentration of
cholesterol in your blood. Both exercise and weight loss can reduce cholesterol concentration. However, it is not known whether exercise or weight loss is best for lowering cholesterol concentration. Therefore, a researcher decided to investigate whether an exercise or weight loss intervention was more effective in lowering cholesterol levels. To this
end, the researcher recruited a random sample of inactive males that were classified as overweight. This sample was then randomly split into two groups: Group 1 underwent a calorie-controlled diet (i.e., the 'diet' group) and Group 2 undertook an exercise-training programme (i.e., the 'exercise' group). In order to determine which treatment
programme was more effective, cholesterol concentrations were compared between the two groups at the end of the treatment programmes. SPSS Statistics Data setup in SPSS Statistics to carry out the Mann-Whitney U test In SPSS Statistics, we entered the scores for cholesterol concentration, our dependent variable, under the variable name
Cholesterol. Next, we created a grouping variable, called Group, which represented our independent variable. Since our independent variable had two groups - 'diet' and 'exercise' - we gave the diet group a value of "1" and the exercise group a value of "2". If you do not label your two groups, SPSS Statistics will not be able to distinguish between
them and the Mann-Whitney U test will not run. Note: There are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and Legacy Dialogs > 2 Independent Samples procedure. How we have explained the data setup above relates to both procedures when your
dependent variable is continuous, which is what we take you through in the Test Procedure in SPSS Statistics section next. However, if you are using the Nonparametric Tests > Independent Samples procedure, you have to make changes to your data setup if your dependent variable is ordinal (i.e., as opposed to being continuous). We explain how to
do this in our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In our enhanced Mann-Whitney U test guide, we show you all the steps required to correctly enter data into SPSS Statistics to run a Mann-Whitney U test for both the Nonparametric Tests > Independent Samples and Legacy Dialogs > 2
Independent Samples procedures discussed in the note above. SPSS Statistics SPSS Statistics procedure to carry out a Mann-Whitney U test If you read assumption #4 earlier, you'll know that the SPSS Statistics procedure when analysing your data using a Mann-Whitney U test is different depending on the shape of the two distributions of your
independent variable. In our example, where our dependent variable is cholesterol concentration, Cholesterol, we are referring to the two distributions of the independent variable, Group (i.e., the distribution of scores for Group 1 the 'diet' group and Group 2 the 'exercise' group). In the 10 steps below, we show you how to analyse your data using a
Mann-Whitney U test in SPSS Statistics when these two distributions have a different shape, and therefore, you have to compare the mean ranks of your dependent variable rather than medians. To use SPSS Statistics to determine whether your two distributions have the same or different shapes, or if you want to know how to use SPSS Statistics to
carry out a Mann-Whitney U test when your two distributions have the same shape, such that you need to compare medians rather than mean ranks, you will need to access the Procedures section of our enhanced Mann-Whitney U test guide (N.B., you can do this by subscribing to Laerd Statistics). Furthermore, the 10 steps below also show you how
to carry out a Mann-Whitney U test using the Legacy Dialogs > 2 Independent Samples procedure in SPSS Statistics. As we explained earlier, there are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and the Legacy Dialogs > 2 Independent Samples procedure.
We recommend the Nonparametric Tests > Independent Samples procedure if your two distributions have the same shape because it is a little easier to carry out, but the Legacy Dialogs > 2 Independent Samples procedure is fine if your two distributions have different shapes. We show you both procedures in our enhanced Mann-Whitney U test
guide. At the end of the 9 steps below, we show you how to interpret the results from this test using mean ranks. Note: The procedure that follows is identical for SPSS Statistics versions 17 to 30, as well as the subscription version of SPSS Statistics, with version 30 and the subscription version being the latest versions of SPSS Statistics. However, in
version 27 and the subscription version, SPSS Statistics introduced a new look to their interface called "SPSS Light", replacing the previous look for versions 26 and earlier versions, which was called "SPSS Standard". Therefore, if you have SPSS Statistics versions 27 to 30 (or the subscription version of SPSS Statistics), the images that follow will be
light grey rather than blue. However, the procedure is identical. Click Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples... on the top menu, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. You will be presented with the Two-Independent-Samples Tests dialogue box, as shown
below: Published with written permission from SPSS Statistics, IBM Corporation. Transfer the dependent variable, Cholesterol, into the Test Variable List: box and the independent variable, Group, into the Grouping Variable: box by using the button or by dragging-and-dropping the variables into the boxes. Published with written permission from
SPSS Statistics, IBM Corporation. Note: Make sure that the Mann-Whitney U checkbox is ticked in the Test Type area and the Grouping Variable: box is highlighted in yellow (as seen above). If it is not highlighted in yellow, simply click your cursor in the Grouping Variable: box to highlight it. Click on the button. The button will not be clickable if you
have not highlighted the Grouping Variable: box as instructed in Step 4. You will be presented with the following screen: Published with written permission from SPSS Statistics, IBM Corporation. Click through to the next page for the remaining procedure and how to interpret the output. Home About Us Contact Us Terms & Conditions Privacy &
Cookies 2018 Lund Research Ltd Take the Tour Plans & Pricing SIGN UP The Mann-Whitney U test is used to compare differences between two independent groups when the dependent variable is either ordinal or continuous, but not normally distributed. For example, you could use the Mann-Whitney U test to understand whether attitudes towards
pay discrimination, where attitudes are measured on an ordinal scale, differ based on gender (i.e., your dependent variable would be "attitudes towards pay discrimination" and your independent variable would be "gender", which has two groups: "male" and "female"). Alternately, you could use the Mann-Whitney U test to understand whether
salaries, measured on a continuous scale, differed based on educational level (i.e., your dependent variable would be "salary" and your independent variable would be "educational level”, which has two groups: "high school" and "university"). The Mann-Whitney U test is often considered the nonparametric alternative to the independent t-test although
this is not always the case. Unlike the independent-samples t-test, the Mann-Whitney U test allows you to draw different conclusions about your data depending on the assumptions you make about your data's distribution. These conclusions can range from simply stating whether the two populations differ through to determining if there are
differences in medians between groups. These different conclusions hinge on the shape of the distributions of your data, which we explain more about later. In our enhanced Mann-Whitney U test guide, we take you through all the steps required to understand when and how to use the Mann-Whitney U test, showing you the required procedures in
SPSS Statistics, and how to interpret and report your output. You can access this enhanced Mann-Whitney U test guide by subscribing to Laerd Statistics. In this "quick start" guide, we show you the basics of the Mann-Whitney U test using one of SPSS Statistics' procedures when the critical assumption of this test is violated. Before we show you how
to do this, we explain the different assumptions that your data must meet in order for a Mann-Whitney U test to give you a valid result. We discuss these assumptions next. SPSS Statistics Assumptions of the Mann-Whitney U test When you choose to analyse your data using a Mann-Whitney U test, part of the process involves checking to make sure
that the data you want to analyse can actually be analysed using a Mann-Whitney U test. You need to do this because it is only appropriate to use a Mann-Whitney U test if your data "passes" four assumptions that are required for a Mann-Whitney U test to give you a valid result. In practice, checking for these four assumptions just adds a little bit
more time to your analysis, requiring you to click a few more buttons in SPSS Statistics when performing your analysis, as well as think a little bit more about your data, but it is not a difficult task. Before we introduce you to these four assumptions, do not be surprised if, when analysing your own data using SPSS Statistics, one or more of these
assumptions is violated (i.e., is not met). This is not uncommon when working with real-world data rather than textbook examples, which often only show you how to carry out a Mann-Whitney U test when everything goes well! However, dont worry. Even when your data fails certain assumptions, there is often a solution to overcome this. First, lets
take a look at these four assumptions: Assumption #1: Your dependent variable should be measured at the ordinal or continuous level. Examples of ordinal variables include Likert items (e.g., a 7-point scale from "strongly agree" through to "strongly disagree"), amongst other ways of ranking categories (e.g., a 5-point scale explaining how much a
customer liked a product, ranging from "Not very much" to "Yes, a lot"). Examples of continuous variables include revision time (measured in hours), intelligence (measured using IQ score), exam performance (measured from 0 to 100), weight (measured in kg), and so forth. You can learn more about ordinal and continuous variables in our article:
Types of Variable. Assumption #2: Your independent variable should consist of two categorical, independent groups. Example independent variables that meet this criterion include gender (2 groups: male or female), employment status (2 groups: employed or unemployed), smoker (2 groups: yes or no), and so forth. Assumption #3: You should have
independence of observations, which means that there is no relationship between the observations in each group or between the groups themselves. For example, there must be different participants in each group with no participant being in more than one group. This is more of a study design issue than something you can test for, but it is an
important assumption of the Mann-Whitney U test. If your study fails this assumption, you will need to use another statistical test instead of the Mann-Whitney U test (e.g., a Wilcoxon signed-rank test). If you are unsure whether your study meets this assumption, you can use our Statistical Test Selector, which is part of our enhanced content.
Assumption #4: A Mann-Whitney U test can be used when your two variables are not normally distributed. However, in order to know how to interpret the results from a Mann-Whitney U test, you have to determine whether your two distributions (i.e., the distribution of scores for both groups of the independent variable; for example, 'males' and
'females' for the independent variable, 'gender') have the same shape. To understand what this means, take a look at the diagram below: Copyright 2013. Laerd Statistics In the two diagrams above, the distribution of scores for 'males' and 'females' have the same shape. In the diagram on the left, you cannot see the distribution of scores for 'males'
(illustrated in blue on the diagram on the right) because the two distributions are identical (i.e., both distributions are identical, so they are 'on top of each other' in the diagram, with the blue-coloured male distribution underneath the red-coloured female distribution). However, in the diagram on the right, even though both distributions have the
same shape, they have a different location (i.e., the distribution of one of the groups of the independent variable has higher or lower values compared to the second distribution in our example, females have 'higher' values than males, overall). When you analyse your own data, it is extremely unlikely that your two distributions will be identical, but
they may have the same (or a 'similar') shape. If they do have the same shape, you can use SPSS Statistics to carry out a Mann-Whitney U test to compare the medians of your dependent variable (e.g., engagement score) for the two groups (e.g., males and females) of the independent variable (e.g., gender) you are interested in. However, if your two
distribution have a different shape, you can only use the Mann-Whitney U test to compare mean ranks. Therefore, when carrying out a Mann-Whitney U test, you must also use SPSS Statistics to determine whether your two distributions have the same shape or a different shape. This requires a few more procedures in SPSS Statistics, but it is an easy
step-by-step process that we show you how to do in our enhanced Mann-Whitney U test guide. In this "quick start" guide, we show you how to carry out a Mann-Whitney U test assuming that your two distributions do not have a similar shape, such that you can only compare mean ranks and not medians. You can check assumption #4 using SPSS
Statistics. Before doing this, you should make sure that your data meets assumptions #1, #2 and #3, although you don't need SPSS Statistics to do this. Just remember that if you do not check assumption #4, you will not know whether you are correctly comparing mean ranks or medians, and the results you get when running a Mann-Whitney U test
may not be valid. This is why we dedicate a number of sections of our enhanced Mann-Whitney U test guide to help you get this right. You can learn more about assumption #4 and what you will need to interpret in the Assumptions section of our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In the
Test Procedure in SPSS Statistics section of this "quick start" guide, we illustrate the SPSS Statistics procedure to perform a Mann-Whitney U test assuming that your two distributions are not the same shape and you have to interpret mean ranks rather than medians. First, we set out the example we use to explain the Mann-Whitney U test procedure
in SPSS Statistics. TAKE THE TOUR PLANS & PRICING The concentration of cholesterol (a type of fat) in the blood is associated with the risk of developing heart disease, such that higher concentrations of cholesterol indicate a higher level of risk, and lower concentrations indicate a lower level of risk. If you lower the concentration of cholesterol in
the blood, your risk for developing heart disease can be reduced. Being overweight and/or physically inactive increases the concentration of cholesterol in your blood. Both exercise and weight loss can reduce cholesterol concentration. However, it is not known whether exercise or weight loss is best for lowering cholesterol concentration. Therefore, a
researcher decided to investigate whether an exercise or weight loss intervention was more effective in lowering cholesterol levels. To this end, the researcher recruited a random sample of inactive males that were classified as overweight. This sample was then randomly split into two groups: Group 1 underwent a calorie-controlled diet (i.e., the
'diet' group) and Group 2 undertook an exercise-training programme (i.e., the 'exercise' group). In order to determine which treatment programme was more effective, cholesterol concentrations were compared between the two groups at the end of the treatment programmes. SPSS Statistics Data setup in SPSS Statistics to carry out the Mann-
Whitney U test In SPSS Statistics, we entered the scores for cholesterol concentration, our dependent variable, under the variable name Cholesterol. Next, we created a grouping variable, called Group, which represented our independent variable. Since our independent variable had two groups - 'diet' and 'exercise' - we gave the diet group a value of
"1" and the exercise group a value of "2". If you do not label your two groups, SPSS Statistics will not be able to distinguish between them and the Mann-Whitney U test will not run. Note: There are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and Legacy
Dialogs > 2 Independent Samples procedure. How we have explained the data setup above relates to both procedures when your dependent variable is continuous, which is what we take you through in the Test Procedure in SPSS Statistics section next. However, if you are using the Nonparametric Tests > Independent Samples procedure, you have
to make changes to your data setup if your dependent variable is ordinal (i.e., as opposed to being continuous). We explain how to do this in our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In our enhanced Mann-Whitney U test guide, we show you all the steps required to correctly enter data into
SPSS Statistics to run a Mann-Whitney U test for both the Nonparametric Tests > Independent Samples and Legacy Dialogs > 2 Independent Samples procedures discussed in the note above. SPSS Statistics SPSS Statistics procedure to carry out a Mann-Whitney U test If you read assumption #4 earlier, you'll know that the SPSS Statistics procedure
when analysing your data using a Mann-Whitney U test is different depending on the shape of the two distributions of your independent variable. In our example, where our dependent variable is cholesterol concentration, Cholesterol, we are referring to the two distributions of the independent variable, Group (i.e., the distribution of scores for Group
1 the 'diet' group and Group 2 the 'exercise' group). In the 10 steps below, we show you how to analyse your data using a Mann-Whitney U test in SPSS Statistics when these two distributions have a different shape, and therefore, you have to compare the mean ranks of your dependent variable rather than medians. To use SPSS Statistics to
determine whether your two distributions have the same or different shapes, or if you want to know how to use SPSS Statistics to carry out a Mann-Whitney U test when your two distributions have the same shape, such that you need to compare medians rather than mean ranks, you will need to access the Procedures section of our enhanced Mann-
Whitney U test guide (N.B., you can do this by subscribing to Laerd Statistics). Furthermore, the 10 steps below also show you how to carry out a Mann-Whitney U test using the Legacy Dialogs > 2 Independent Samples procedure in SPSS Statistics. As we explained earlier, there are two different procedures in SPSS Statistics to run a Mann-Whitney
U test: the Nonparametric Tests > Independent Samples procedure and the Legacy Dialogs > 2 Independent Samples procedure. We recommend the Nonparametric Tests > Independent Samples procedure if your two distributions have the same shape because it is a little easier to carry out, but the Legacy Dialogs > 2 Independent Samples
procedure is fine if your two distributions have different shapes. We show you both procedures in our enhanced Mann-Whitney U test guide. At the end of the 9 steps below, we show you how to interpret the results from this test using mean ranks. Note: The procedure that follows is identical for SPSS Statistics versions 17 to 30, as well as the
subscription version of SPSS Statistics, with version 30 and the subscription version being the latest versions of SPSS Statistics. However, in version 27 and the subscription version, SPSS Statistics introduced a new look to their interface called "SPSS Light", replacing the previous look for versions 26 and earlier versions, which was called "SPSS
Standard". Therefore, if you have SPSS Statistics versions 27 to 30 (or the subscription version of SPSS Statistics), the images that follow will be light grey rather than blue. However, the procedure is identical. Click Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples... on the top menu, as shown below: Published with written
permission from SPSS Statistics, IBM Corporation. You will be presented with the Two-Independent-Samples Tests dialogue box, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. Transfer the dependent variable, Cholesterol, into the Test Variable List: box and the independent variable, Group, into the
Grouping Variable: box by using the button or by dragging-and-dropping the variables into the boxes. Published with written permission from SPSS Statistics, IBM Corporation. Note: Make sure that the Mann-Whitney U checkbox is ticked in the Test Type area and the Grouping Variable: box is highlighted in yellow (as seen above). If it is not
highlighted in yellow, simply click your cursor in the Grouping Variable: box to highlight it. Click on the button. The button will not be clickable if you have not highlighted the Grouping Variable: box as instructed in Step 4. You will be presented with the following screen: Published with written permission from SPSS Statistics, IBM Corporation. Click
through to the next page for the remaining procedure and how to interpret the output. Home About Us Contact Us Terms & Conditions Privacy & Cookies 2018 Lund Research Ltd In this tutorial, well look at how to conduct the Mann-Whitney U Test in SPSS, and also at how to interpret the result of the test.The Mann-Whitney U Test evaluates
whether two samples are likely to originate from the same underlying population, and it tends to be used in situations where an independent-samples t test is not appropriate (for example, if either of the sample distributions are non-normal).Click Analyze -> Nonparametric Tests -> Legacy Dialogs -> 2 Independent Samples.Drag and drop the
dependent variable into the Test Variable(s) box, and the grouping variable into the Grouping Variable box.Tick Mann-Whitney U under Test Type.Click on Define Groups, and input the values that define each of the groups that make up the grouping variable (i.e., the coded value for Group 1 and the coded value for Group 2).Press Continue, and then
click on OK to run the test.The result will appear in the SPSS data viewer.For this tutorial, were using data from a fake study that looks at the relationship between dog ownership and the ability to throw a frisbee. The DataAs per usual, were working on the assumption that youve opened SPSS, youre looking at the Data View, and it looks something
like this.In our example, Frisbee Throwing Distance in Metres is the dependent variable, and Dog Owner is the grouping variable. Put simply, we want to know whether owning a dog (independent variable) has any effect on the ability to throw a frisbee (dependent variable).Assumption of NormalityGiven this setup, it would be usual to conduct an
independent samples t test. One assumption of this parametric test is that data is normally distributed. The trouble is if we test our data for normality, we get this result.Both Kolmogorov-Smirnov and Shapiro-Wilk suggest that our dependent variable is not distributed normally. This is confirmed by the histogram, which has a long left tail.This means
were better off using a non-parametric test to determine whether there is a relationship between our independent and dependent variables (though, actually, since we have a large number of observations, wed probably get away with the t test). The obvious choice here is the Mann-Whitney U test.Mann-Whitney U TestTo begin, click Analyze ->
Nonparametric Tests -> Legacy Dialogs -> 2 Independent Samples. This will bring up the Two-Independent-Samples Tests dialog box.The setup here is not too difficult.To perform the Mann-Whitney U test, weve got to get our dependent variable (Frisbee Throwing Distance) into the Test Variable List box, and our grouping variable (Dog Owner) into
the Grouping Variable box. To move the variables over, you can either drag and drop, or use the blue arrows.You also need to select Mann-Whitney U under Test Type (by ticking the box).The dialog should now look something like this.Youll notice that the Grouping Variable, DogOwner, has two question marks in brackets after it. This indicates that
you need to define the groups that make up the grouping variable. Click on the Define Groups button.Were using 0 and 1 to specify each group, because these values match the way the variable is coded (the Data View shows value labels, not the underlying numeric values). 0 is No Dog; and 1 is Owns Dog.Its also worth noting that if you had coded
your grouping variable as a String type, then youd need to match the string values that appear in the Data View precisely for example, No Dog and Owns Dog.Once you have specified the values that define each group, press the Continue button, and then click on OK in the main dialog box to run the Mann-Whitney U test. The ResultThe result will
appear in the SPSS Output Viewer.The Mann-Whitney test works by converting scores into ranks while ignoring the grouping variable (in our example, ownership and non-ownership of a dog), and then comparing the mean rank of each group. If the difference between the mean ranks is big enough to be significant, then the null hypothesis that the
samples derive from the same population is rejected.As you can see above, there is what looks like a sizeable difference between the mean ranks of the No Dog and Owns Dog groups. The Mann-Whitney test statistic will tell us whether this difference is big enough to reach significance.SPSS produces a test statistics table to summarise the result of
the Mann-Whitney U test. The key values are Mann-Whitney U, Z and the 2-tailed significance score.In our example, the No Dog group comprises greater than 20 observations. This means we can use the value of Z to derive our p-value. Otherwise, the significance value comes from U.SPSS is reporting a Z score of -2.049 and a 2-tailed p-value of .040.
This would normally be considered a significant result (the standard alpha level is .05). Therefore, we can be confident in rejecting the null hypothesis that holds that the Owns Dog and No Dog groups are drawn from the same underlying population. Or, to put this another way, the result of the Mann-Whitney U test supports the proposition that
owners and non-owners of dogs have different frisbee throwing abilities. ****¥¥¥xxxxxx%*%Qkay, thats the end of this tutorial. You should now have a good idea of how to perform the Mann-Whitney U test in SPSS, and how to interpret the result. You may also be interested in our tutorials on: (1) exporting your SPSS output to another application such as
Word, Excel, or PDF and (2) reporting Mann-Whitney U test results from SPSS in APA style. Take the Tour Plans & Pricing SIGN UP The Mann-Whitney U test is used to compare differences between two independent groups when the dependent variable is either ordinal or continuous, but not normally distributed. For example, you could use the
Mann-Whitney U test to understand whether attitudes towards pay discrimination, where attitudes are measured on an ordinal scale, differ based on gender (i.e., your dependent variable would be "attitudes towards pay discrimination" and your independent variable would be "gender", which has two groups: "male" and "female"). Alternately, you
could use the Mann-Whitney U test to understand whether salaries, measured on a continuous scale, differed based on educational level (i.e., your dependent variable would be "salary" and your independent variable would be "educational level", which has two groups: "high school" and "university"). The Mann-Whitney U test is often considered the
nonparametric alternative to the independent t-test although this is not always the case. Unlike the independent-samples t-test, the Mann-Whitney U test allows you to draw different conclusions about your data depending on the assumptions you make about your data's distribution. These conclusions can range from simply stating whether the two
populations differ through to determining if there are differences in medians between groups. These different conclusions hinge on the shape of the distributions of your data, which we explain more about later. In our enhanced Mann-Whitney U test guide, we take you through all the steps required to understand when and how to use the Mann-
Whitney U test, showing you the required procedures in SPSS Statistics, and how to interpret and report your output. You can access this enhanced Mann-Whitney U test guide by subscribing to Laerd Statistics. In this "quick start" guide, we show you the basics of the Mann-Whitney U test using one of SPSS Statistics' procedures when the critical
assumption of this test is violated. Before we show you how to do this, we explain the different assumptions that your data must meet in order for a Mann-Whitney U test to give you a valid result. We discuss these assumptions next. SPSS Statistics Assumptions of the Mann-Whitney U test When you choose to analyse your data using a Mann-Whitney
U test, part of the process involves checking to make sure that the data you want to analyse can actually be analysed using a Mann-Whitney U test. You need to do this because it is only appropriate to use a Mann-Whitney U test if your data "passes" four assumptions that are required for a Mann-Whitney U test to give you a valid result. In practice,
checking for these four assumptions just adds a little bit more time to your analysis, requiring you to click a few more buttons in SPSS Statistics when performing your analysis, as well as think a little bit more about your data, but it is not a difficult task. Before we introduce you to these four assumptions, do not be surprised if, when analysing your
own data using SPSS Statistics, one or more of these assumptions is violated (i.e., is not met). This is not uncommon when working with real-world data rather than textbook examples, which often only show you how to carry out a Mann-Whitney U test when everything goes well! However, dont worry. Even when your data fails certain assumptions,
there is often a solution to overcome this. First, lets take a look at these four assumptions: Assumption #1: Your dependent variable should be measured at the ordinal or continuous level. Examples of ordinal variables include Likert items (e.g., a 7-point scale from "strongly agree" through to "strongly disagree"), amongst other ways of ranking
categories (e.g., a 5-point scale explaining how much a customer liked a product, ranging from "Not very much" to "Yes, a lot"). Examples of continuous variables include revision time (measured in hours), intelligence (measured using IQ score), exam performance (measured from 0 to 100), weight (measured in kg), and so forth. You can learn more
about ordinal and continuous variables in our article: Types of Variable. Assumption #2: Your independent variable should consist of two categorical, independent groups. Example independent variables that meet this criterion include gender (2 groups: male or female), employment status (2 groups: employed or unemployed), smoker (2 groups: yes
or no), and so forth. Assumption #3: You should have independence of observations, which means that there is no relationship between the observations in each group or between the groups themselves. For example, there must be different participants in each group with no participant being in more than one group. This is more of a study design
issue than something you can test for, but it is an important assumption of the Mann-Whitney U test. If your study fails this assumption, you will need to use another statistical test instead of the Mann-Whitney U test (e.g., a Wilcoxon signed-rank test). If you are unsure whether your study meets this assumption, you can use our Statistical Test
Selector, which is part of our enhanced content. Assumption #4: A Mann-Whitney U test can be used when your two variables are not normally distributed. However, in order to know how to interpret the results from a Mann-Whitney U test, you have to determine whether your two distributions (i.e., the distribution of scores for both groups of the
independent variable; for example, 'males' and 'females' for the independent variable, 'gender') have the same shape. To understand what this means, take a look at the diagram below: Copyright 2013. Laerd Statistics In the two diagrams above, the distribution of scores for 'males' and 'females' have the same shape. In the diagram on the left, you
cannot see the distribution of scores for 'males' (illustrated in blue on the diagram on the right) because the two distributions are identical (i.e., both distributions are identical, so they are 'on top of each other' in the diagram, with the blue-coloured male distribution underneath the red-coloured female distribution). However, in the diagram on the
right, even though both distributions have the same shape, they have a different location (i.e., the distribution of one of the groups of the independent variable has higher or lower values compared to the second distribution in our example, females have 'higher' values than males, overall). When you analyse your own data, it is extremely unlikely that
your two distributions will be identical, but they may have the same (or a 'similar') shape. If they do have the same shape, you can use SPSS Statistics to carry out a Mann-Whitney U test to compare the medians of your dependent variable (e.g., engagement score) for the two groups (e.g., males and females) of the independent variable (e.g., gender)
you are interested in. However, if your two distribution have a different shape, you can only use the Mann-Whitney U test to compare mean ranks. Therefore, when carrying out a Mann-Whitney U test, you must also use SPSS Statistics to determine whether your two distributions have the same shape or a different shape. This requires a few more
procedures in SPSS Statistics, but it is an easy step-by-step process that we show you how to do in our enhanced Mann-Whitney U test guide. In this "quick start" guide, we show you how to carry out a Mann-Whitney U test assuming that your two distributions do not have a similar shape, such that you can only compare mean ranks and not medians.
You can check assumption #4 using SPSS Statistics. Before doing this, you should make sure that your data meets assumptions #1, #2 and #3, although you don't need SPSS Statistics to do this. Just remember that if you do not check assumption #4, you will not know whether you are correctly comparing mean ranks or medians, and the results you
get when running a Mann-Whitney U test may not be valid. This is why we dedicate a number of sections of our enhanced Mann-Whitney U test guide to help you get this right. You can learn more about assumption #4 and what you will need to interpret in the Assumptions section of our enhanced Mann-Whitney U test guide, which you can access by
subscribing to Laerd Statistics. In the Test Procedure in SPSS Statistics section of this "quick start" guide, we illustrate the SPSS Statistics procedure to perform a Mann-Whitney U test assuming that your two distributions are not the same shape and you have to interpret mean ranks rather than medians. First, we set out the example we use to
explain the Mann-Whitney U test procedure in SPSS Statistics. TAKE THE TOUR PLANS & PRICING The concentration of cholesterol (a type of fat) in the blood is associated with the risk of developing heart disease, such that higher concentrations of cholesterol indicate a higher level of risk, and lower concentrations indicate a lower level of risk. If
you lower the concentration of cholesterol in the blood, your risk for developing heart disease can be reduced. Being overweight and/or physically inactive increases the concentration of cholesterol in your blood. Both exercise and weight loss can reduce cholesterol concentration. However, it is not known whether exercise or weight loss is best for
lowering cholesterol concentration. Therefore, a researcher decided to investigate whether an exercise or weight loss intervention was more effective in lowering cholesterol levels. To this end, the researcher recruited a random sample of inactive males that were classified as overweight. This sample was then randomly split into two groups: Group 1
underwent a calorie-controlled diet (i.e., the 'diet' group) and Group 2 undertook an exercise-training programme (i.e., the 'exercise' group). In order to determine which treatment programme was more effective, cholesterol concentrations were compared between the two groups at the end of the treatment programmes. SPSS Statistics Data setup in
SPSS Statistics to carry out the Mann-Whitney U test In SPSS Statistics, we entered the scores for cholesterol concentration, our dependent variable, under the variable name Cholesterol. Next, we created a grouping variable, called Group, which represented our independent variable. Since our independent variable had two groups - 'diet' and
'exercise' - we gave the diet group a value of "1" and the exercise group a value of "2". If you do not label your two groups, SPSS Statistics will not be able to distinguish between them and the Mann-Whitney U test will not run. Note: There are two different procedures in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests >
Independent Samples procedure and Legacy Dialogs > 2 Independent Samples procedure. How we have explained the data setup above relates to both procedures when your dependent variable is continuous, which is what we take you through in the Test Procedure in SPSS Statistics section next. However, if you are using the Nonparametric Tests >
Independent Samples procedure, you have to make changes to your data setup if your dependent variable is ordinal (i.e., as opposed to being continuous). We explain how to do this in our enhanced Mann-Whitney U test guide, which you can access by subscribing to Laerd Statistics. In our enhanced Mann-Whitney U test guide, we show you all the
steps required to correctly enter data into SPSS Statistics to run a Mann-Whitney U test for both the Nonparametric Tests > Independent Samples and Legacy Dialogs > 2 Independent Samples procedures discussed in the note above. SPSS Statistics SPSS Statistics procedure to carry out a Mann-Whitney U test If you read assumption #4 earlier,
you'll know that the SPSS Statistics procedure when analysing your data using a Mann-Whitney U test is different depending on the shape of the two distributions of your independent variable. In our example, where our dependent variable is cholesterol concentration, Cholesterol, we are referring to the two distributions of the independent variable,
Group (i.e., the distribution of scores for Group 1 the 'diet' group and Group 2 the 'exercise' group). In the 10 steps below, we show you how to analyse your data using a Mann-Whitney U test in SPSS Statistics when these two distributions have a different shape, and therefore, you have to compare the mean ranks of your dependent variable rather
than medians. To use SPSS Statistics to determine whether your two distributions have the same or different shapes, or if you want to know how to use SPSS Statistics to carry out a Mann-Whitney U test when your two distributions have the same shape, such that you need to compare medians rather than mean ranks, you will need to access the
Procedures section of our enhanced Mann-Whitney U test guide (N.B., you can do this by subscribing to Laerd Statistics). Furthermore, the 10 steps below also show you how to carry out a Mann-Whitney U test using the Legacy Dialogs > 2 Independent Samples procedure in SPSS Statistics. As we explained earlier, there are two different procedures
in SPSS Statistics to run a Mann-Whitney U test: the Nonparametric Tests > Independent Samples procedure and the Legacy Dialogs > 2 Independent Samples procedure. We recommend the Nonparametric Tests > Independent Samples procedure if your two distributions have the same shape because it is a little easier to carry out, but the Legacy
Dialogs > 2 Independent Samples procedure is fine if your two distributions have different shapes. We show you both procedures in our enhanced Mann-Whitney U test guide. At the end of the 9 steps below, we show you how to interpret the results from this test using mean ranks. Note: The procedure that follows is identical for SPSS Statistics
versions 17 to 30, as well as the subscription version of SPSS Statistics, with version 30 and the subscription version being the latest versions of SPSS Statistics. However, in version 27 and the subscription version, SPSS Statistics introduced a new look to their interface called "SPSS Light", replacing the previous look for versions 26 and earlier
versions, which was called "SPSS Standard". Therefore, if you have SPSS Statistics versions 27 to 30 (or the subscription version of SPSS Statistics), the images that follow will be light grey rather than blue. However, the procedure is identical. Click Analyze > Nonparametric Tests > Legacy Dialogs > 2 Independent Samples... on the top menu, as
shown below: Published with written permission from SPSS Statistics, IBM Corporation. You will be presented with the Two-Independent-Samples Tests dialogue box, as shown below: Published with written permission from SPSS Statistics, IBM Corporation. Transfer the dependent variable, Cholesterol, into the Test Variable List: box and the
independent variable, Group, into the Grouping Variable: box by using the button or by dragging-and-dropping the variables into the boxes. Published with written permission from SPSS Statistics, IBM Corporation. Note: Make sure that the Mann-Whitney U checkbox is ticked in the Test Type area and the Grouping Variable: box is highlighted in
yellow (as seen above). If it is not highlighted in yellow, simply click your cursor in the Grouping Variable: box to highlight it. Click on the button. The button will not be clickable if you have not highlighted the Grouping Variable: box as instructed in Step 4. You will be presented with the following screen: Published with written permission from SPSS
Statistics, IBM Corporation. Click through to the next page for the remaining procedure and how to interpret the output. Home About Us Contact Us Terms & Conditions Privacy & Cookies 2018 Lund Research Ltd
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